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 เอกสารประกอบการสอนรายวิชาการเขียนโปรแกรมคอมพิวเตอร์แบบวิชวล รหัสวิชา 4132303 
เล่มนี้ได้เรียบเรียงขึ้นเพ่ือให้นักศึกษา ได้ใช้เป็นแหล่งเรียนรู้ด้วยตนเอง ซึ่งสาระส าคัญตรงกับค าอธิบาย
รายวิชาในหลักสูตรสาขาวิชาสถิติประยุกต์ ของมหาวิทยาลัยราชภัฏบุรี รัมย์ พร้อมทั้งมีตัวอย่างและ
แบบฝึกหัดประกอบอย่างครบถ้วนเพ่ือเสริมการเรียนรู้ได้ดียิ่งขึ้นส าหรับการเรียนการสอน โดยแต่ละหัวข้อ
มีความจ าเป็นในการใช้เวลาเรียนรู้ การท าความเข้าใจ และการปฏิบัติให้เกิดทักษะแตกต่างกัน  
 รายวิชานี้มุ่งเน้นให้ผู้เรียนมีความรู้ ความเข้าใจเกี่ยวกับหลักพ้ืนฐานของการเขียนโปรแกรม
คอมพิวเตอร์แบบวิชวล ส่วนประกอบคุณลักษณะ  และเหตุการณ์ การออกแบบสร้างฟอร์มและเมนู การ
ประมวลผลฐานข้อมูล การท าโครงงานพัฒนาระบบงานประมวลผลสารสนเทศ  โดยใช้โปรแกรมภาษา
แบบวิชวลภาษาใดภาษาหนึ่ง 
 ผู้เขียนขอขอบคุณเจ้าของเอกสาร หนังสือ ต ารา บทความ และสื่อต่าง ๆ ที่ผู้เขียนยึดถือเป็น
บรรทัดฐานในการเรียบเรียง ขอขอบคุณเจ้าหน้าที่ส านักวิทยบริการและเทคโนโลยีสารสนเทศท่ีได้อ านวย
ความสะดวกในการสืบค้นข้อมูล และขอขอบคุณผู้เป็นก าลังใจทุกท่าน จนผลงานส าเร็จลุล่วงลงได้ด้วยดี 
ผู้เขียนหวังอย่างยิ่งว่าเอกสารประกอบการสอนฉบับนี้ จะช่วยเอ้ือประโยชน์ต่อผู้เรียน ผู้ที่ต้องการศึกษา
เพ่ิมเติมความรู้ รวมถึงผู้สนใจทั่วไปได้น าไปใช้ประโยชน์ในชีวิตประจ าวัน หรืออาจมองไกลถึงการใช้เป็น
พ้ืนฐานเพื่อก้าวสู่การประกอบอาชีพในอนาคตได้ตามที่ตั้งใจไว้ 
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Chapter 1  
เครื่องมือและการใช้งาน Visual Basic เบื้องต้น 

 
1.1 ท าความรู้จัก Microsoft Visual Studio 
 Microsoft Visual Studio คือ ชุดพัฒนาโปรแกรม (Integrated Development Environment) 
ประกอบด้วยโปรแกรมหลายๆ ตัวที่ใช้ในการสร้างโปรแกรมส าเร็จรูปบนระบบปฏิบัติการวินโดวส์ หรือใช้สร้าง
เว็บโปรแกรม สร้างเว็บบริการ จัดการฐานข้อมูล และอ่ืนๆ อีกมากมาย  
 Visual Studio ได้รวบรวมเครื่องมือพัฒนาต่างๆ ที่ใช้ในการพัฒนาโปรแกรมตั้งแต่ หน้าจอท่ีใช้พัฒนา
โปรแกรม (Development interface) เครื่องมือในการตรวจหาจุดผิดในโปรแกรม (Debugging tool) ตัวช่วย
อัตโนมัติในการเขียนโปรแกรม (Wizard tool) ตัวจัดการฐานข้อมูล (Database management) และ
ส่วนประกอบอ่ืนๆที่จ าเป็นในการพัฒนาโปรแกรม น ามาประกอบกันเป็นชุด เรียกว่า Integrated 
Development Environment (ชุดพัฒนาโปรแกรม) หรือเรียกย่อๆ ว่า IDE 
 
1.2 ความสามารถของ Visual Studio  
 เป็นชุดพัฒนาจากบริษัทไมโครซอฟท์ (Microsoft) ใช้ในการสร้างสิ่งต่างๆ ต่อไปนี้ 

 โปรแกรม (Program) 
 เว็บไซต์ (Website) 
 โปรแกรมบนเว็บ (Web application) 
 บริการบนเว็บ (Web service) 
 คลาวด์แอพ (Cloud apps) จดัการ และเผยแพร่คลาวด์แอพผ่านระบบคลาวด์ของบริษัท

ไมโครซอฟท์ที่มีชื่อว่า Azure 
 แอพบนอุปกรณ์พกพา (Mobile apps)  
 เกมส์ (Games) 
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1.3 เครื่องมือในชุด Visual Studio  
 Visual Studio ได้รวมหลายๆ เครื่องมือที่ใช้ในการเขียนโปรแกรมภาษาต่างๆ และสามารถเขียนโปรแกรม
จากภาษาใดก็ได้ตามท่ีเราถนัด โดยมีเครื่องมือดังต่อไปนี้ 

 Visual Basic  
 Visual C++ 
 Visual C# 
 Visual F# 
 Python 
 JavaScript 

 
1.4 การติดตั้ง Visual Studio 
 ในการติดตั้ง Visual Studio ปัจจุบันนี้เป็น Version 2019 ซึ่งสามารถดาวน์โหลดได้ฟรี และติดตั้งตาม
ขั้นตอนดังต่อไปนี้ 
 1.4.1 เริ่มต้นเข้าสู่เว็บไซต์ https://visualstudio.microsoft.com เมนู Visual Studio IDE เลือก
Download Visual Studio -> Community 2019 ตามภาพท่ี 1.1 
 

 
ภาพที่ 1.1 

 
 
 

https://visualstudio.microsoft.com/
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 1.4.2 จะปรากฏแถบแสดงสถานะให้เลือกโฟลเดอร์ที่จะบันทึกโปรแกรมท่ีดาวน์โหลดเก็บไว้ในเครื่อง 
 1.4.3 เปิดโฟลเดอร์ที่ท าการบันทึกโปรแกรมไว้ แล้วท าการ Run เพ่ือท าการติดตั้ง จะปรากฏหน้าต่าง
แสดงสถานะการดาวน์โหลด Visual Studio ขั้นตอนนี้จะใช้เวลานานพอสมควร ตามภาพที่ 1.2 
 

 
ภาพที่ 1.2 

 
 1.4.4 ขั้นตอนต่อไป เมื่อดาวน์โหลดเสร็จ จะมีหน้าต่าง installing ขึ้นมา ให้ท าการเลือกท่ีหัวข้อ .NET 
desktop development แล้วกดปุ่ม Install ตามภาพที ่1.3 

 
ภาพที่ 1.3 
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 1.4.5 หลังจากกดปุ่ม install ท าการรอให้โปรแกรมดาวน์โหลดและติดตั้งอีกครั้งหนึ่ง ใช้เวลาพอสมควร
ขึ้นอยู่กับความเร็วอินเทอร์เน็ต ตามภาพท่ี 1.5 

 
ภาพที่ 1.5 

 
 1.4.6 เมื่อติดตั้งโปรแกรมเสร็จเรียบร้อยแล้วท าการเปิดใช้งาน Visual Studio ครั้งแรก ให้ท าการ
ลงทะเบียน หรือ Sign in เพ่ือลงทะเบียนผู้ใช้ใหม่ (จะเหมือนกับการสมัครอีเมลล์ outlook)  ท าการเลือก
สภาพแวดล้อมที่ถนัด 

 
ภาพที่ 1.6 
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1.5 เริ่มต้นใช้งาน Visual Basic 
 เราจะเริ่มใช้งาน Visual Basic ซึ่งจะใช้ค าย่อว่า VB โดยเราจะอธิบายถึงส่วนประกอบต่างๆ และกล่าวถึง
หลักการเขียนโปรแกรมด้วย VB ที่จ าเป็นต้องทราบ โดยประยุกต์ใช้สิ่งต่างๆ ดังนี้ 
 1.5.1 สร้างโปรเจ็กต์และรู้จักส่วนการท างานใน Visual Studio 
  1) โปรเจกต์ (Project) คือ โครงการส้างแอพพลิเคชันที่ประกอบด้วยไฟล์การท างานรวมอยู่ในชุด
เดียวกัน เริ่มต้นเราจะสร้างโปรเจ็กต์ใหม่ จากนั้นจะแสดงส่วนการท างานต่างๆ ออกมามากมายให้ได้ศึกษา ดังนี้ 

 
ภาพที่ 1.7 

 
  2) เลือกเทมเพลตต้นแบบ Windows Forms App (.Net Framework) แล้วกดปุ่ม Next ตาม
ภาพที่ 1.8 

 
ภาพที่ 1.8 
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  3) ท าการตั้งชื่อโปรเจ็กต์ เลือก Location ที่ต้องการบันทึก แล้วกดปุ่ม Create ภาพที่ 1.9 

 
ภาพที่ 1.9 

  4) ปรากฏฟอร์มว่างส าหรับออกแบบหน้าจอโปรแกรมและแสดงส่วนการท างานต่างๆ ภาพที่ 1.10 
มีรายละเอียดดังนี้ 
 
 

 
ภาพที่ 1.10 

เมนูบาร์ (Menu Bar) ทูลบาร ์(Tool Bar) หน้าต่างแสดงโปรเจ็กต ์(Solution Explorer) 

หน้าต่างคุณสมบัติ (Properties Window) 

ฟอร์มว่างส าหรับออกแบบหนา้ตาของโปรแกรมของเรา (Form) 

แหล่งข้อมูล (Data 
Source) 

ทลูบ็อกซ์ (Tool Box) 
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 เมนูบาร์ (Menu bar) เป็นแถบรวมค าสั่งทังหมดใน VB 
 ทูลบาร์ (Toolbar) เก็บเฉพาะบางค าสั่ง แต่เป็นค าสั่งที่ใช้บ่อย 
 ทูลบ็อกซ์ (Toolbox) เก็บคอนโทรลและคอมโพเนนต์ต่างๆ ที่เราสามารถเลือกไปวางลงบนฟอร์ม

ได้ เพื่อออกแบบหน้าจอโปรแกรม (เรียกว่าส่วนติดต่อผู้ใช้ หรือ User Interface 
 หน้าต่างแสดงโปรเจกต์ (Solution Explorer) เป็นหน้าต่างแสดงรายละเอียดของไฟล์และโมดูลที่

มีในโปรเจ็กต์ 
 หน้าต่างคุณสมบัติ (Properties Window) เป็นหน้าต่างที่แสดงคุณสมบัติของคอนโทรลและ

คอมโพเนนต์ที่เลือกอยู่ในขณะนั้น ซึ่งเราสามารถปรับแต่งคุณสมบัติเพ่ิมเติมได้ เช่น ก าหนด
ข้อความ ปรับสี ปรับขนาด ขึ้นอยู่กับออบเจ็กต์ท่ีเลือก 

 ฟอร์ม (Form) พ้ืนที่ที่ใช้ในการออกแบบหน้าจอโปรแกรม โดยให้เราลากคอนโทรลและ
คอมโพเนนต์มาจัดวางประกอบกันตามต้องการ 

 แหล่งข้อมูล (Data Sources) สร้างการเชื่อมต่อและติดต่อฐานข้อมูล 
 

  5) หน้าต่าง Code Editor และหน้าต่าง Designer 
   เราสามารถเรียกหน้าต่าง Code Editor ที่ให้ใส่ค าสั่งเพ่ือควบคุมการท างานของโปรแกรม โดย
การเลือกค าสั่ง View -> Code หรือกด F7 แต่ถ้าต้องการสลับไปท างานบนหน้าต่าง Designer ให้เลือกค าสั่ง 
View -> Designer หรือกด Shift+F7 ตามภาพท่ี 1.11 

  

ภาพที่ 1.11 
  6) การจัดการคอนโทรลและการก าหนดอีเวนต์ 
   6.1) การจัดการคอนโทรล การเพ่ิมคอนโทรลลงบนฟอร์ม ให้ท าดังนี้ ภาพที่ 1.12 และเรา
สามารถก าหนดคุณสมบัติต่างๆได้ที่หน้าต่างคุณสมบัติ (Properties Window) 
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ภาพที่ 1.12 

   
   6.2) การก าหนดอีเวนต์ 
    Code Editor เป็นหน้าต่างที่เราใส่ค าสั่งของ VB ลงไป เพื่อตอบสนองต่ออีเวนต์ต่างๆ ที่
เกิดข้ึน เราสามารถเปิด/ปิดหน้าต่างนี้ได้ โดยกดปุ่ม F7 หรอืเลือกเมนู View->Code กรณีนี้ เราจะลองใช้ค าสั่ง 
MessageBox.Show ในโปรแกรม แล้วท าการทดสอบโปรแกรม 

 
ภาพที่ 1.13 

 
  7) การบันทึกโปรแกรม 
   โปรแกรมท่ีเราพัฒนาด้วย VB   จะประกอบด้วยส่วนย่อยๆ เรียกว่า โมดูล (Module) ซึ่งโมดูล
เหล่านี้ เมื่อน ามารวมกัน เราจะเรียกว่า โปรเจ็กต์ (Project) การบันทึกโปรแกรมที่เราสร้าง ก็คือ การบันทึก
โปรเจ็กต์ ซึ่งจะมีอยู่ 3 วิธี คือ 
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 การบันทึกไฟล์ในโปรเจ็กต์ท้ังหมด ให้เราเลือก File -> Save All ซึ่งระบบจะสร้างโฟลเดอร์
ย่อยส าหรับจัดเก็บโปรเจ็กต์และสร้างไฟล์โปรเจ็กต์ต่ามชื่อของโปรเจ็กต์ แลหากเราใช้ค าสั่ง
นี้ในครั้งต่อไป ก็จะเป็นการบันทึกอัพเดตไฟล์ที่ก าลังเปิดท างานในโปรเจ็กต์ท้ังหมด 

 การบันทึกโปรเจ็กต์ในชื่อเดิม ให้เราเลือก File -> Save [ชือ่ของโปรเจ็กต์] ถ้ามีไฟล์ใหม่ที่
เพ่ิงสร้างแต่ยังไม่ถูกบันทึก VB จะให้เราตั้งชื่อไฟล์นั้นเพื่อท าการบันทึกด้วย 

 การบันทึกโปรเจ็กต์ในชื่อใหม่ ให้เราเลือก File -> Save [ ] as จะเป็นการสร้างโปรเจ็กต์ชื่อ
ใหม่ โดยโปรเจ็กต์ชื่อเดิมก็ยังคงอยู่เหมือนเดิม 

  8) การทดสอบโปรแกรม 
   เราสามารถรันโปรแกรมเพ่ือตรวจสอบการท างาน โดยกดปุ่ม F5 หรือเลือกค าสั่ง Debug -> 
Start Debugging 
   หากต้องการยุติการทดสอบโปรแกรม ให้คลิกท่ีปุ่มกากบาทปิดของโปรแกรม หรือกดปุ่ม 
<Ctrl+Alt+Bre-ak> หรือค าสั่ง Debug -> Stop Debugging  
  9) เริ่มต้นสร้างโปรแกรมแรก 
   ส าหรับในโปรแกรมนี้ จะสร้างโปรแกรมท่ีรับข้อความจากผู้ใช้ เมื่อมีการคลิกเมาส์ปุ่ม Say 
Hello ก็จะแสดงข้อความท่ีได้รับอยู่บนกล่องข้อความ ดังนี้ 

 
ภาพที่ 1.14 

   - เลือกคอนโทรลต่างๆ จากทูลบ็อกซ์ (ToolBox) มาวางบนฟอร์ม 
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ภาพที่ 1.15 

 
   - ก าหนดคุณสมบัติของคอนโทรลต่างๆ ที่หน้าต่าง Properties 
   - เลือกเมนู View->Code เพ่ือเปิดหน้าต่างเขียนโค้ดค าสั่ง (Code Editor) 
   - สร้างการตอบสนองที่ต้องการ ในตัวอย่างคือ กดปุ่ม Button1 ให้โชว์ข้อความ ดังนั้น หน้าต่าง
เขียน Code ค าสั่ง ให้เราเลือก Button1 และเลือกอีเวนต์ Click ดังรูป 

 
ภาพที่ 1.16 

 
 

   - ท าการเพิ่ม Code ค าสั่งดังรูป 
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ภาพที่ 1.17 

   - ค าสั่ง MsgBox จะแสดงกล่องข้อความ (Message Box) ที่มีข้อความแจ้งเตือน โดยเราจ า
ก าหนดค่าไว้ 2 ค่า คั่นด้วยเครื่องหมา (,) คือข้อความที่แสดงและปุ่มกด 
    ค าแรก “Hello, “ & TextBox1.Text แสดงค าว่า Hello (ตัวอักษรที่อยู่ในเครื่องหมาย    
(“   “) จะนับเป็นข้อความ ไม่ใช่ค าสั่ง) จากนั้นต่อด้วยข้อความที่อยู่ใน TextBox1 ซึ่งจะเป็นข้อความที่เราพิมพ์
ลงในคอนโทรล โดยท าการเชื่อมข้อความทั้งสองด้วยเครื่องหมาย & 
    ค าที่สอง MsgBoxStyle.OkOnly เป็นการก าหนดปุ่มที่จะแสดงในกล่องข้อความ 
   - จากนั้นท าการรันโปรแกรม และทดสอบโปรแกรม 



Chapter 2 

การออกแบบหน้าจอและการใช้คอนโทรลพื้นฐาน 

 

 การสร้างโปรแกรมด้วย VB ในข้ันตอนแรกๆ จะเป็นการออกแบบหน้าจอที่ติดต่อกับผู้ใช้ โดยน าคอนโทรลที่

มีอยู่มาออกแบบฟอรม์ให้เหมาะสม จ าเห็นได้ว่าทั้งฟอร์มและคอนโทรลนั้นเป็นเครื่องมือพื้นฐานทีส่ าคัญในการ

เขียนโปรแกรม VB ส าหรบับนน้ีจะกล่าวถึงหลักการพื้นฐานเกี่ยวกับฟอร์ม และคอนโทรลที่ควรทราบ เพือ่ให้

เข้าใจหลักการออกแบบหน้าจอมากยิ่งข้ึน 

 

2.1 คุณสมบัติ เมธอด และอีเวนต์ 

 ในการท างานกับฟอร์มและคอนโทรล เราจะต้องท าความคุ้นเคยกับ 3 ค าต่อไปนี้ คือ คุณสมบัติ 

(Properties), เมธอด (Method) และ อีเวนต์ (Event) 

 2.1.1 คุณสมบัติ (Properties)  

  เราก าหนดลกัษณะต่างๆของ ฟอร์มและคอนโทรล เช่น ปุ่มค าสั่ง ช่ือ Button1 มีคุณสมบัติทีเ่รา

ก าหนดได ้

 
ภาพท่ี 2.1 

 2.1.2 เมธอด (Method)  

  ความสามารถของ Object เป็นค าสั่งใหฟ้อรม์และคอนโทรลท างานตามที่เราต้องการ 

 

 

คณุสมบติั Text 

คณุสมบติั Height 

คณุสมบติั Width 
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 2.1.3 อีเวนต์ (Event) 

  เป็นเหตุการณ์ที่เกิดข้ึนกับฟอร์ม หรือคอนโทรลทีเ่ราสามารถใส่ค าสั่งเพื่อตอบสนองได้ เช่น ถ้าเรา

ต้องการตอบสนองต่ออเีวนต์ Click ของปุ่มค าสัง่ช่ือ Button1 ให้เราดับเบลิคลิกปุ่มเพื่อเข้าสูห่น้าต่างการเขียน

โค้ด และใส่ค าสั่ง Button1.Text = “Click” จากนั้นเมื่อรันโปรแกรมให้คลิกปุ่มค าสัง่บนหน้าต่างโปรแกรม 

สังเกตเห็นค าว่า “Button1” บนปุม่ค าสั่ง จะเป็นเป็น “Click” ดังภาพที่ 2.2 

 
ภาพท่ี 2.2 

 

2.2 เนมสเปซ (Namespaces) 

 หลักการทีส่ าคัญมากอย่างหนึ่งในการเขียนโปรแกรม VB กคื็อ เนมสเปซ ซึง่จะช่วยให้การจัดการไลบรารี 

คลาส และออบเจ็กต์ต่างๆ ได้ง่ายข้ึน ท าให้ไม่เกิดความก ากวมเมื่ออ้างอิงถึงออบเจก็ต์ และระบบขอบเขตการ

ใช้งานของออบเจ็กต์ รายละเอียดของเนมสเปซจะกล่าวในบทการเขียนโปรแกรมเชิงวัตถุ ส่วนบทนีจ้ะกล่าวถึง

วิธีการอ้างอิงถึงเนมสเปซ 

 การอ้างองิเนมสเปซ ท าให้เราเรียกใช้คลาสได้ง่าย เช่น คลาส System.WinForms.Button เป็นการ

เรียกช่ือแบบเตม็ๆ ซึง่ยาวและยุ่งยาก แต่ถ้าเราอ้างองิด้วยค าสั่ง import ดังตัวอย่าง 

 
 ท าให้เราสามารถเรียกใช้คลาสภายใน WinForms ทั้งหมดได้ในทันที เช่น เรียกใช้คลาส Button แทนการ

ใช้ค าว่า System.WinForms.Button ซึ่งจะสั้นกว่าและสะดวกกว่ามาก 

 

2.3 การใช้งานฟอร์ม (Windows Forms) 

 2.3.1 ฟอร์ม หรอืที่เรียกว่า WinForms เป็นเครื่องมือที่ใช้บ่อยมากในการสร้างโปรแกรมด้วย VB โดยผู้ใช้

จะติดต่อท างานผ่านทางคอนโทรลต่างๆ ที่เราวางบนฟอรม์  

 ฟอร์มและคอนโทรลต่างๆ ที่มีใน VB นั้น เป็นคลาสที่มีอยู่ในเนมสเปซช่ือ System.Windows.Forms ซึ่ง

จะมีคลาสต่างๆ ที่ช่วยเราในการสร้างแอพพลิเคชันที่รันบนวินโดวส์ (ส าหรับความหมายของคลาสและออบ
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เจ็กต์ เราจะกล่าวถึงรายละเอียดเพิ่มเติม ในบทเรื่องการเขียนโปรแกรมเชิงวัตถุ) โดยเนมสเปซ 

System.Windows.Forms จะมีใช้ในโปรเจ็กต์เราอยู่แล้วตั้งแต่แรก โดยสามารถเข้าไปดูได้ที่หน้าต่าง Solution 

คลิกขวาที่ช่ือโปรเจคแล้วเลือก Properties จากนั้นไปที่เมนู References ดังภาพที่ 2.3 

 

 
ภาพท่ี 2.3 

 

 2.3.2 คุณสมบัติทีส่ าคัญของฟอรม์ 

  ฟอร์มมีคุณสมบัติต่างๆ มากมาย แต่ที่เราจ าเป็นต้องรู้จกั มดีังต่อไปนี้ 

ชื่อคุณสมบัติ ค าอธิบาย 
Name * ก าหนดช่ือของฟอร์มที่เราใช้อ้างอิงถึงในโปรแกรม 
FormBorderStyle ก าหนดลกัษณะการเปลี่ยนขนาดขอบของฟอรม์ 
MinimizeBox หรือ 
MaximizeBox 

ก าหนดว่าให้ขยายหรือย่อฟอร์ม 

ControlBox ก าหนดให้ฟอร์มมีเมนูระบบทางมมุซ้ายบนสุดด้วยหรือไม่ 
Text * ก าหนดข้อความที่แสดงบนไตเตลิบาร์ของฟอร์ม 
Icon ก าหนดรปูไอคอนของฟอร์มเมื่อยอ่ (Minimize) ฟอร์ม 
Size * ก าหนด Height : ความสูง และ Width : ความกว้างของฟอร์ม 
Location * ก าหนดต าแหน่งของฟอร์มโดยคิดจากต าแหน่งบนซ้ายของหน้าจอ 
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ชื่อคุณสมบัติ ค าอธิบาย 
WindowState ก าหนดว่าเมื่อเริม่ต้นเรียกฟอร์ม จะให้อยู่ในแบบขยาย 

(Maximize), แบบย่อ (Minimize) หรือแบบธรรมดา 
Enabled * ก าหนดให้ฟอร์มสามารถตอบสนองตอ่อีเวนต์ได้หรือไม่ 
TopMost ก าหนดว่าฟอรม์นี้จะแสดงอยูเ่หนอืฟอร์มอื่นๆ เสมอหรือไม่ 

 หมายเหตุ * เป็นคุณสมบัติที่ใช้กบัคอนโทรลอื่นได้ โดยมีความหมายใกล้เคียงกัน 

 

 2.3.3 เมธอดและอีเวนต์ทีส่ าคัญของฟอร์ม 

  ฟอร์มมีเมธอดและอเีวนต์ที่เราจ าเป็นต้องรูจ้ัก ดังตารางต่อไปนี้ 

ชื่อเมธอด, อีเวนต์ ค าอธิบาย 
Load เป็นอเีวนต์ที่เกิดเมื่อเรียกฟอรม์ขึ้นมาครัง้แรก 
Resize เป็นอเีวนต์ที่เกิดเมื่อมีการเปลี่ยนขนาดของฟอร์ม 
Activated เป็นอเีวนต์ที่เกิดข้ึนเมื่อฟอร์มนั้นเป็นฟอรม์ที่เราก าลังท างานด้วย 
Deactivate เป็นอเีวนต์ที่เกิดเมื่อฟอรม์อื่นๆ กลายเป็นฟอรม์ที่แอคทฟีแทน 
Click เป็นอเีวนต์ที่เกิดเมื่อมีการใช้เมาส์คลิกบนฟอรม์ 
DoubleClick เป็นอเีวนต์ที่เกิดเมื่อมีการใช้เมาส์ดบัเบิ้ลคลิกบนฟอรม์ 
Show เป็นเมธอดที่ใช้แสดงฟอรม์ขึ้นมา 
Hide เป็นเมธอดที่ใช้ซ่อนฟอร์มไว้ 
Close เป็นเมธอดที่ใช้ปิดฟอร์ม 
Activate เป็นเมธอดที่ใช้ท าให้ฟอร์มถูกเลือกใช้งานในขณะนั้น 

 

 2.3.4 ตัวอย่างโปรแกรมแสดงการท างานของฟอร์ม 

ตัวอย่างนี้เป็นเป็นโปรแกรมที่ช่วยให้เราเข้าใจสิ่งต่างๆ เกี่ยวกับฟอร์มมากยิ่งข้ึน ซึ่งเป็นการส ร้างฟอร์มหนึ่ง

ฟอร์ม และแสดงอีเวนต์ต่างๆ ทีเกิดข้ึนบนฟอร์มว่าเกิดข้ึนในตอนใด ดูผลลัพธ์ได้จากหน้าต่าง Output โดย

โปรแกรมจะเรียกเมธอด WriteLine ของออบเจ็กต์ Console ค าสั่ง Console.WriteLine เพื่อพิมพ์ช่ืออีเวนต์ที่

เกิดข้ึนบนฟอร์มออกมา โดยมีการท างานดังนี้ 
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ภาพท่ี 2.4 

 

 ขั้นตอนการสร้างโปรเจ็กต์ 

 1) สร้างโปรเจ็กต์ใหม่ชนิด Windows Forms App  

 2) เลือก View -> Code หรือ กด F7 เพื่อเปิดหน้าต่างโค้ดข้ึนมา จากนั้นให้เลือกอีเวนต์ต่างๆ ของฟอร์ม

ตามค าสั่งในโปรแกรม โดยเลือกจาก (Form1 Events) และเลือกอีเวนต์ของฟอร์ที่ต้องการตอบสนอง ในที่นี้

เลือก 6 อีเวนต์ คือ Load, Activated, Click, Deactivate, DoubleClick, Resize 

 
ภาพท่ี 2.5 สร้างโปรเจก็ต์ใหม ่
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ภาพท่ี 2.6 เลือก (Form1 Events) และเลอืกอเีวนต์ตอบสนอง 6 ตัว 

 

 
ภาพท่ี 2.7 โปรแกรมย่อยหลังจากทีเ่ลือกอีเวนต์ 
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 3) จากนั้นในหน้าต่างโค้ดโปรแกรม ใหเ้ราใส่ค าสัง่โปรแกรมต่อไปนี้ลงไปในอีเวนต์ต่างๆ ดังนี้ 

 
ภาพท่ี 2.8 

 4) บันทึกโปรเจ็กต์และรันทดสอบโปรแกรม โดยเลือก Debug และคลิก Start โดยผลลัพธ์การรัน

โปรแกรมจะปรากฏช่ือ Form1 ข้ึนมา และเมื่อมีอีเวนต์เกิดข้ึน โปรแกรมจะพิมพ์อีเวนต์ที่เกิดข้ึนบนหน้าต่าง 

Output ดังรูป 

  
ภาพท่ี 2.9 
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 เพ่ิมเติม ค าสั่ง Console.WriteLine จะมีประโยชน์มากในการแสดงค่าข้อมูลในโปรแกรมของเราออกมา

ทางหน้าต่าง Output สามารถเรียกข้ึนมาแสดงได้โดยไปที่เมนู View-> Output หรือกดปุ่ม <Ctrl+Alt+O> 

 

 2.3.5 คอนโทรลและคอมโพเนนต์พื้นฐาน 

  ทูลบ็อกซ์ ประกอบด้วยเครื่องมือที่ใช้น ามาวางบนฟอร์มเพื่ออกแบบส่วนติดต่อผู้ใช้งาน มีเครื่องมือ 

2 ประเภท คือ คอนโทรล ออบเจ็กต์ที่วางบนฟอร์มที่ผู้ใช้สามารถมองเห็น เช่น ปุ่ม กล่องข้อความ เป็นต้น และ 

คอมโพเนนต ์ออบเจ็กต์ที่วางบนฟอร์มแต่ผู้ใช้มองไม่เห็น เช่น การนับเวลา เป็นต้น 

 

คอนโทรล ค าอธิบาย 
Button ให้ผู้ใช้คลิกสั่งงานมายังโปรแกรม 
Label แสดงข้อมูลให้ผู้ใช้เห็นเพียงอย่างเดียว 
Textbox รับข้อมูลจากผู้ใช้ที่ป้อนเข้ามาในโปรแกรมและแสดงผลข้อมูล 
CheckBox ให้ผู้ใช้เลือกได้มากกว่า 1 ตัวเลือก 
RadioButton ให้ผู้ใช้เลือกได้ตัวใดตัวหนึ่งจากกลุ่มตัวเลือกทั้งหมด 
ListBox ให้ผู้ใช้เลือกโดยการเลื่อนดูรายการที่ต้องการได้ 
ComboBox ให้ผู้ใช้เลือกคล้ายกับลิสต์บ็อกซ์ แต่สามารถพิมพ์ข้อมูลเข้าไปได้ด้วย 
CheckedListBox ให้ผู้ใช้เลือกรายการได้โดยเช็กที่หน้ารายการนั้น 
GroupBox รวมคอนโทรลให้อยู่ในกลุ่มเดียวกัน 
PictureBox ใส่ภาพประกอบและตกแต่งให้สื่อความหมายและสวยงาม 
ScrollBar เลื่อนดูข้อมูลทั้งหมดที่ไม่สามารถแสดงในคราวเดียวบนพื้นที่ที่จ ากัด 

 

คอมโพเนนต์ ค าอธิบาย 
Timer ใช้นับเวลาตามช่วงเวลาที่ก าหนดเพื่อควบคอมการท างานบางอย่าง 
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  2.3.5.1 คอนโทรลปุ่มค าสั่ง (Button) 

   ปุ่มค าสั่งมีหน้าที่หลักคือ ตอบสนองต่อการคลิกเมาส์ของผู้ใช้งานที่สั่งงานมายังโปรแกรมว่า 

ต้องการให้โปรแกรมท าอะไรต่อ  

  ตัวอย่างโปรแกรมที่ใช้ปุ่มค าสั่ง 

  ในตัวอย่างนี้ จะแสดงการใช้งานปุ่มค าสั่ง ถ้าเราไม่ใส่ข้อความในเท็กซ์บ็อกซ์ ปุ่มค าสั่งจะไม่

ตอบสนองการท างาน แต่ถ้าเราใส่ข้อความในเท็กซ์บ็อกซ์ ปุ่มค าสั่งจะตอบสนองต่อการคลิกเมาส์ โดยแสดงช่ือ

ที่พิมพ์ในเท็กซ์บ็อกซ์บนกล่องข้อความ 

   1) สร้างโปรเจคใหม่ชนิด Windows Forms App จากนั้นให้วางคอนโทรล และเปลียนช่ือ

ปุ่มกับลาเบล ดังภาพที่ 2.10 

 
ภาพท่ี 2.10 

    

   2) สังเกตได้ว่าที่ปุ่มมีรูปภาพไอคอนเพิ่มข้ึนมา โดยโปรแกรม Visual Studio มีคลังภาพให

นักพัฒนาโปรแกรมสามารถดาวน์โหลดมาใช้ประกอบในโปรแกรมได้ฟรี เรียกว่า Visual Studio Image 

Library ในตัวอย่างเราจะใช้ไฟล์ภาพ UserProfile_16x.png มาตกแต่งบนปุ่ม มีขั้นตอนดังนี้ 

   - เปิดเว็บ Google แล้ว Search ค าว่า Microsoft Visual Studio Image Library 

   - เข้าเว็บ https://www.microsoft.com/en-us/download/details.aspx?id=35825 

   - คลิกที่ Download 

   - เลือก VS2017 Image Library.zip จากนั้นคลกิปุ่ม Next 

   - ท าการ Save บันทึกไว้ในเครื่องคอมพิวเตอร ์

   - จะได้ไฟล์ VS2017 Image Library.zip ที่เก็บภาพไอคอนและกราฟฟิกจ านวนมาก 
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   - จากนั้นแตกไฟล์ .zip ออกมา แล้วหาโฟลเดอร์ UserProfile 

   - ก็อปปี้ไฟล์ UserProfile_16x.png มาใส่ในโฟลเดอร์โปรเจ็กต์ของเรา 

   - คลิกเลือกคอนโทรลปุ่มทีเ่ราต้องการวางภาพประกอบ 

   - ที่หน้าต่าง Properties ให้คลิกก าหนดคุณสมบัติ Image ที่   เพื่อใส่ภาพปุ่ม 

   - จะปรากฏหน้าต่าง Select Resource ที่ Project resource file ให้คลิก Import เพื่อ

เข้าไปเลอืกไฟล์ภาพที่ต้องการน ามาวางบนปุ่ม 

   - ปรากฏหน้าต่าง Open ให้เลอืกไฟล์ภาพที่จัดเตรียมเพื่อน ามาวางบนปุม่และคลิก Open 

   - กลบัมาทีห่น้าต่าง Select Resource ที่ Project resource file ให้เลือก 

UserProfil_16x และคลิกปุม่ OK จากนั้นภาพจะถูกวางบนปุ่ม ท าการจัดต าแหนง่ให้เรียบร้อยที่หน้าต่าง 

Properties ก าหนดคุณสมบัตที่ ImageAlign 

   3) ดับเบลิคลกิบนปุ่มเพื่อเข้าสู่ Code Editor จากนั้นสร้างโค้ดอีเวนต์ 

TextBox1_TextChanged แล้วให้ใส่ค าสั่งภายในอีเวนต์ต่างๆ ดังนี ้

 
ภาพท่ี 2.10 

   
ภาพท่ี 2.11 
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  2.3.5.2 คอนโทรลเท็กซบ์็อกซ์ (TextBox) 

   เป็นคอนโทรลที่เราใช้บ่อยมากในการรับข้อมูลจากผู้ใช้ที่ป้อนเข้ามาในโปรแกรม รวมทั้ง

สามารถแสดงผลและใหผู้้ใช้แก้ไขข้อมูลได้ด้วย การปรับแต่งจะอยู่ในส่วยของ Properties 

 

ตัวอย่างโปรแกรมแสดงการใช้งานเลเบล เท็กซ์บ็อกซ์ และปุม่กด 

ข้ันตอนการสร้างโปรแกรม 

  1) สร้างโปรเจคใหมเ่ป็นชนิด Windows Forms App จากนั้นวางคอนโทรลต่างๆ บนฟอรม์ และ

ก าหนดคุณสมบัติ ดังนี ้

 
ภาพท่ี 2.12 

  2) ดับเบิล้คลิกที่ปุม่ Login เพื่อเข้าสูห่น้า Code Editor ให้ใส่ค าสั่งใน Event Button1_Click 

จากนั้นดับเบลิคลิกที่ว่างบนฟอรม์สร้างโค้ดอเีวนต์ Form1_Load และใส่โค้ดการท างานดงันี ้
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ภาพท่ี 2.13 

 

  3) รันโปรแกรมทีส่ร้างมา จะได้ผลลัพธ์ดังรปู 

 
ภาพท่ี 2.14 

 

  2.3.5.3 คอนโทรลเช็กบ็อกซ์ (CheckBox) 

    คอนโทรลเช็กบ็อกซ์จะให้ผู้ใช้เลือกว่าจะเช็ก หรือไมเ่ช็ก เพียงอย่างใดอย่างหนึง่

เท่านั้น ค่าของคอนโทรลเช็กบ็อกซจ์ะอยู่ในคุณสมบัติ Checked ที่มีค่าเป็น True หรือ False หรือคุณสมบัติ 

CheckState  

ตัวอย่างโปรแกรมแสดงการใช้งานเช็กบ็อกซ์ 

  ตัวอย่างต่อไปนี้เป็นโปรแกรมแสดงการท างานของเช็กบ็อกซ์ โดยเราจะใช้เช็กบ็อกซ์ในการเลือกว่า

ต้องการตัวอักษรแบบตัวเน้น (Bold) หรือแบบตัวเอียง (Italic) จากนั้นจะปรากฏกล่องข้อความแสดงสิ่งที่เรา

เลือก 

ข้ันตอนการสร้างโปรแกรม 

  1) สร้างโปรเจคชนิด Windows Forms App ใหม่ข้ึนมา และให้เราวางคอนโทรลต่างๆ ตามรูป  

 
ภาพท่ี 2.15 
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  2) ไปที่หน้าต่าง Code Editor จากนั้นใส่ค าสั่งโปรแกรมดงันี้ 

 

 
ภาพท่ี 2.16 

  3) รันโปรแกรมทีส่ร้างมาจะไดผ้ลลัพธ์ดังรูป 

 
ภาพท่ี 2.17 
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  2.3.5.4 คอนโทรลเรดิโอบัตทอน (RadioButton) 

   คอนโทรลเรดิโอบัตทอน ท าหน้าที่คล้ายกบัเช็กบ็อกซ์ แต่คอนโทรลนี้จะสามารถเลือก

ได้เพียงตัวเลอืกเดียวเท่านั้นในกลุ่มหนึง่ 

Example จากโจทย์เดมิข้างต้น ให้เปลี่ยนจาก CheckBox เป็น RadioButton โดยให้เลอืก Bold กับ Italic 

เหมอืนเดิม แล้วรันให้ได้ผลลพัธ์ออกมาตามที่เลือก 

  2.3.5.5 คอนโทรลกรุ๊ปบอ็กซ์ (GroupBox) 

    คอนโทรลกรุป๊บ็อกซ์ใช้ส าหรจัักลุ่มคอนโทรลที่ใช้ร่วมกัน ช่วยเพิ่มความเรียนร้อย 

และความสวยงามของหน้าตาโปรแกรมมากขึ้น เช่น ใช้แบ่งเรดิโอบัตทอน บนฟอร์มออกเป็นกลุ่มๆ เป็นต้น 

ตัวอย่างโปรแกรมการใช้งานกรุ๊ปบ็อกซ ์

  เป็นการใช้กรุป๊บ็อกซ์จัดกกลุม่ เรดโิอบัตทอน เช็กบ็อกซ์ และคอนโทรลอื่นๆ ออกแบบหน้าจอเป็น

แบบฟอร์มส าหรับผู้ใช้กรอกข้อมลู และเมื่อคลกิปุ่ม Ok จะแสดงข้อมลูทัง้หมดบนกล่องข้อควา 

  1) สร้างโปรเจคใหม่ขึ้นมาชนิด Windows Forms App ช่ือ GroupBox และให้คอนโทรลต่างๆ ลง

บนฟอรม์ พร้อมทั้งก าหนดคุณสมบัติต่างๆดังนี ้

 
ภาพท่ี 2.18 
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  2) ดับเบิล้คลิ๊กที่ปุม่ Button1 จะแสดงหน้าต่าง Code Editor จากนั้นใส่โค้ดโปรแกรม ดังนี ้

 
ภาพท่ี 2.19 
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  3) รันโปรแกรมทีส่ร้างมาจะไดผ้ลลัพธ์ ดังภาพ 

  
ภาพท่ี 2.20 

 

  2.3.5.6 คอนโทรลลสิต์บอ็กซ์ (ListBox) 

   เราจะสงัเกตได้ว่าทั้งเรดโิอบัตทอนและเช็กบ็อกซ์นั้น ถ้าน ามาใช้แสดงตัวเลอืกหลายๆตัว 

จะใช้เนื้อทีบ่นฟอร์มพอสมควร ในกรณีนี้เราสามารถน าเอาคอนโทรลลสิต์บอ็กซม์าใช้แทนที่การแสดงตัวเลือก

หลายๆ ตัวได้ในแบบของรายการ  

ตัวอย่างโปรแกรมการใช้งานลิสตบ์็อกซ์ 

  1) สร้างโปรเจ็กต์ใหม่ชนิด Windows Forms App ข้ึนมา กดคอนโทรลลิสตบ์็อกซม์าวางบนฟอร์ม 

 
ภาพท่ี 2.21 
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  2) ไปที่หน้าต่าง Code Editor และใสโ่ค้ดโปรแกรมดงนี ้

 
ภาพท่ี 2.22 

  เมื่อเปิดแสดงหน้าจอโปรแกรมจะเริ่มท างานอีเวนต์ Form1_Load โดยเพิ่มรายการเข้าไปในลิสต์

บอกซ์ด้วยค าสั่ง Item.Add() จ านวน 5 รายการ สุดท้ายจะหาค่าในรายการที่ต าแหน่ง Index(0) โดยให้พิมพ์

แสดงค่าผลลัพธ์ในหน้าต่าง Output 

  3) คลิก Start เพื่อรันโปรแกรม จะแสดงรายการแรกสุดออกมาทางหน้าต่าง Output คือ One 

 
ภาพท่ี 2.23 

  4) ให้เพิ่มโค้ดในส่วนอีเวนต์ ListBox1_SelectedIndexChanged เพื่อให้ท างานเมื่อมีการเลอืก

รายการ โดยให้แสดงค่าจากรายการที่ถูกเลอืกด้วยคุณสมบตัิ Text เป็นผลลัพธ์หน้าต่าง Output ดังนี ้
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ภาพท่ี 2.24 

 

  5) เมื่อรันโปรแกรม จะแสดงรายการบนลสิต์บ็อกซ์ จากนั้นให้ผู้ใช้เลือกรายการ กจ็ะน าค่าจาก

คุณสมบัติ Text ออกมาแสดงในหน้าต่าง Output 

 
ภาพท่ี 2.25 

  6) เราสามารถหาจ านวนของรายการในลิสตบ์็อกซ์ โดยใช้คุณสมบัติ Count ของลสิต์บ็อกซ์ เช่น 

 
ภาพท่ี 2.26 
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  7) เราสามารถก าหนดว่าจะใหผู้้ใช้เลือกรายการในลิสตบ์็อกซ์ได้ทีละรายการหรือหลายรายการ โดย

ก าหนดที่คุณสมบัติ SelectionMode ซึ่งแต่ละค่าจะมีความหมายดังนี ้

 
ภาพท่ี 2.27 

- None ไม่สามารถเลือกได้ หมายถึง ลสิต์บ็อกซ์ที่แสดงอย่างเดียว ไม่สามารถเลือกได้ 

- One เลอืกได้รายการเดียว เป็นลสิต์บ็อกซ์แบบทั่วไป 

- MultiSimple เลอืกได้หลายรายการแบบ 1 กด <Spacebar> จะเป็นการเลือก

รายการในลิสตบ์็อกซ ์

- MultiExtended เลือกได้หลายรายการแบบ 2 โดยมีวิธีการกดปุ่มเลือกอยู่ 2 แบบ คือ  

 กดปุ่ม <Shift> พร้อมกบัการคลิก จะเป็นการเลอืกรายการที่อยู่ระหว่างที่

เลือกไว้ก่อนหน้ากบัรายการทีเ่ลอืกไว้ในปัจจุบัน 

 กดปุ่ม <Ctrl> พร้อมกบัการคลิกรายการที่ต้องการ จะเป็นการเลือกรายการ

ต่างๆ ในลิสตบ์็อกซ ์

  ส าหรับลิสตบ์็อกซ์ที่เลือกไดห้ลายรายการ เราสามารถทราบว่าผู้ใช้ได้เลือกรายการใด โดยการ

ตรวจสอบคุณสมบัติ SelectedItems ซึ่งเป็นคอลเล็กชันทีเ่ก็บออบเจ็กต์ Item ที่ผู้ใช้เลือกไว้ นอกจากนี้ยังมี

คุณสมบัติ SelectedIndices ที่เกบ็อินเดก็ซ์รายการแตล่ะตวัที่ผู้ใช้เลือกไว้ในลิสตบ์็อกซ์ ดังรูป 
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ภาพท่ี 2.28 

  สรุป Items รายการตัวเลือก SelectedItems ก็คือ กลุ่มของ Items ที่ถูกเลือก ส่วน Items ที่ไม่

เลือกจะไม่อยู่ในกลุ่มนี้ ดังนั้น SelectedItems จึงเป็นซับเซตของ Items เสมอ จากภาพ 2.28 จะเห็นว่า 

Items จะมี Index 5 ต าแหน่ง แต่ SelectedItems จะมี Index เพียง 3 ต าแหน่ง โดยค่าของ Index ใน Items 

และ SelectedItems จะอ้างอิงถึงรายการที่แตกต่างกัน เช่น Index ค่า 1 ใน Items คือรายการ Two แต่ค่า

ใน SelectedItems จะเป็นรายการ Three ซึ่งจุดน้ีเป็นจุดที่ท าให้สับสนและงงกันมาก 

  เพิ่มเติม จาก Code เดิม ให้ก าหนดคุณสมบัติของ SelectionMode ของลิสต์บ็อกซ์ในหน้าต่าง

คุ ณ ส ม บั ติ เ ป็ น  MultiExtended จ า ก นั้ น ไ ป ที่ ห น้ า ต่ า ง  Code Editor แ ล้ ว ส ร้ า ง โ ค้ ด อี เ ว น ต์  

SelectionIndexChanged ของ ListBox1 ให้ท างานเมื่อผู้ใช้เลือกรายการโดยจะแสดงรายการที่ถูกเลือกด้วย

คุณสมบัติ SelectedItem ดังนี ้

 
ภาพท่ี 2.29 

ListBox1.Item(0) 

ListBox1.Item(1) 

ListBox1.Item(2) 

ListBox1.Item(3) 

ListBox1.Item(4) 

 

 

ListBox1.SelectedItem(0)

ListBox1.SelectedItem(1)

ListBox1.SelectedItem(2) 
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  เมื่อรันโปรแกรม จะแสดงรายการทั้งหมดทีผู่้ใช้เลือกบนหนา้ต่าง Output 

 
ภาพท่ี 2.30 

 

  2.3.5.7 คอนโทรลคอมโบบ็อกซ์ (ComboBox) 

   คอมโบบ็อกซ์ จะรวมความสามารถของเท็กซ์บ็อกซ์และลิสต์บ็อกซ์เข้าไว้ด้วยกัน ท าให้เรา

สามารถเลือกรายการได้เช่นเดียวกับลิสต์บ็อกซ์ และแก้ไขรายการได้เหมือนกับเท็กซ์บ็อกซ์ แต่ใช้พื้นที่น้อยกว่า

ลิสต์บ็อกซ์ และใช้ค าสั่งในการท างานคล้ายกัน ดังนั้นเราสามารถน าความรู้เกี่ยวกับลิสต์บ็อกซ์มาใช้กับคอมโบ 

บ็อกซ์ได้ 

  การก าหนดค่ารูปแบบของคอมโบบ็อกซ์ เราจะก าหนดผ่านทางคุณสมบัติ DropDownStyle โดย

คอมโบบ็อกซ์มีอยู่ 3 รูปแบบ ได้แก่ 

   - ซิมเปิลคอมโบบ็อกซ์ (Simple ComboBox) เป็นคอมโบบ็อกซ์ที่แสดงรายการอยู่

ตลอดเวลา และเมื่อจ านวนรายการเกินความสูงของคอนโทรล คอนโทรลจะแสดงสกอลบาร์แนวตั้ง เพื่อใช้เลื่อน

ดูรายการที่เหลือได้ 

   - ดร็อปดาวน์คอมโบบ็อกซ์ (Dropdown ComboBox) เป็นคอมโบบ็อกซ์ที่ผู้ใช้สามารถใส่

ค่าลงไปได้โดยตรง หรือเลือกจากรายการที่มีอยู่ก็ได้ โดยการคลิกที่ปุ่มลูกศรลง เมื่อเลือกตัวเลือกใดในรายการ

แล้ว ตัวเลือกนั้นจะแสดงอยู่ช่องบนสุดของคอนโทรล 

   - ดร็อปดาวน์ลิสต์บ็อกซ์ (Dropdown ListBox) เป็นคอมโบบ็อกซ์ที่คล้ายกับลิสต์บ็อกซ์ 

แต่จะประหยัดเนื้อที่ที่ใช้แสดงรายการมากกว่า โดยที่ผู้ใช้ไม่สามารถใส่ค่าเองได้ จะเลือกข้อมูลจากรายการที่มี

อยู่ได้เท่านั้น 



22 
 

ตัวอย่างการใช้งานโปรแกรมลิสต์บ็อกซ์และคอมโบบ็อกซ์ 

  1) สร้างโปรเจคใหม่ชนิด Windows Forms App ข้ึนมา และให้วางคอนโทรลต่างๆ ลงบนฟอร์ม

พร้อมทั้งก าหนดคุณสมบัติต่างๆ ของฟอร์ม ดังภาพ 

 
ภาพท่ี 2.31 

  2) ดับเบิล้คลิกที่พื้นที่ว่างบนฟอร์ม จะได้ Events Load ข้ึนมา และเข้าสูห่น้า Code Editor  จะ

ท าการสร้างโค้ดอีเวนต์ Form1_Load เอาไว้ แล้วให้เราใสค่่าเริ่มต้นของลสิต์บ็อกซ์และคอมโบบ็อกซ์เพิ่มเตมิ

ดังนี้ 

 
ภาพท่ี 2.32 
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  3) คลิกที่ลสิต์บอ็กซ์ จากนั้นไปทีห่น้าต่างคุณสมบัติและแทบ็ Events ให้ดับเบิ้ลคลิ๊กทีอ่ีเวนต์ 

SelectedIndexChanged จะเข้าสู่หน้าต่าง Code Editor ส าหรับเขียนโปรแกรม จากนั้นให้ใส่โค้ดแสดง

ข้อความจากรายการทีผู่้ใช้เลือกในลสิต์บ็อกซป์รากฎในกล่องข้อความ 

  4) คลิกที่คอมโบบอ็กซ์ จากนั้นไปทีห่น้าต่างคุณสมบัติและแท็บ Events ให้ดับเบิล้คลิกที่อีเวนต์ 

TextChanged จะเข้าสู่หน้าต่าง Code Editor ส าหรับเขียนโปรแกรม จากนั้นให้ใสโ่ค้ดแสดงข้อความจาก

รายการที่ผู้ใช้เลือกในคอมโบบ็อกซ์ให้ปรากฎในกล่องข้อความ 

 
ภาพท่ี 2.33 

 

  5) รันโปรแกรม จะแสดงผลลัพธ์ดังภาพ 

 

                   
ภาพท่ี 2.34 
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ตัวอย่างโปรแกรมแสดงการเพิ่มและลบรายการในลสิต์บอ็กซ์/คอมโบบ็อกซ์ 

  1) สร้างโปรเจคใหม่ชนิด Windows Forms App ข้ึนมา และให้วางคอนโทรลต่างๆ บนฟอร์ม 

พร้อมก าหนดคุณสมบัติ ดังภาพ 

 
ภาพท่ี 2.35 

 

  2) เขียนโปรแกรมให้กับปุ่ม Add โดยดับเบิลคลิกปุ่ม Add จะปรากฏหน้าต่าง Code Editor และ

เกิดอีเวนต์ Button1_Click จากนั้นให้ใส่โค้ดรับข้อมูลจากเท็กซ์บ็อกซ์มาเพิ่มเป็นรายการอยู่ในลิสต์บ็อกซ์ 

  3) เขียนโปรแกรมให้กับปุ่ม Remove โดยดับเบิลคลิกปุ่ม Remove จะเกิดอีเวนต์ Button2_Click 

จากนั้นให้ใส่โค้ดตรวจสอบว่าผู้ใช้ได้เลือกรายการในลิสต์บ็อกซ์เพื่อจะลบออกหรือไม่ ถ้ามีจะถอดรายการที่

เลือกออก ถ้าไม่มีจะแจ้งผ่านกล่องข้อความว่าไม่สามารถถอดรายการออกได้ 

  4) เขียนโปรแกรมให้กับปุ่ม Clear โดยดับเบิลคลิกปุ่ม Clear จะเกิดอีเวนต์ Button3_Click 

จากนั้นให้ใส่โค้ดลบรายการทั้งหมดออกจากลิสต์บ็อกซ์ ดังภาพ 

Label 

TextBox 

ListBox 



25 
 

 
ภาพท่ี 2.36 

  5) ท าการคลกิรันโปรแกรม ทดสอบผลลัพธ์ที่ได้ดังภาพ 

 
ภาพท่ี 2.37 
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  2.3.5.8 คอนโทรลพิกเจอร์บอ็กซ์ (PictureBox) 

    เป็นคอนโทรลที่ใช้แสดงภาพและยังสร้างเป็นภาพแบ็กกราวด์ให้กับฟอร์มได้ด้วย ซึ่ง

การน ารูปภาพ ไอคอน หรือภาพสัญลักษณ์ต่างๆ มาใช้บนฟอร์มจะช่วยสื่อความหมายผู้ใช้งานได้ดียิ่งขึ้น 

ตัวอย่างโปรแกรมการเพิ่มและซ่อนภาพในพิกเจอร์บ็อกซ์ 

  1) สร้างโปรเจคชนิดใหม่เป็นชนิด Windows Forms App ข้ึนมา จากนั้นให้วางคอนโทรลพิกเจอร์

บ็อกซ์และปุ่มบนฟอร์ม ตามภาพ 

 
ภาพท่ี 2.38 

  2) คลิกเลือกคอนโทรลพิกเจอร์ ไปที่  Properties และคลิกคุณสมบัต Image เพื่อเข้าไปเลือก

รูปภาพที่จะน ามาแสดงในคอนโทรลพิกเจอร์ โดยให้น าภาพมาเก็บไว้ใน Resources เพราะเมื่อเราบิลด์

โปรแกรมจะแพ็กเกจไฟล์ภาพน้ีไปด้วย ท าให้สามารถรันโปรแกรมแดสงภาพบนเครื่องต่างๆ ได้อย่างถูกต้อง 

 
ภาพท่ี 2.39 
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  3) เขียนโปรแกรมให้กับปุ่ม Show และ Hide  

 
ภาพท่ี 2.40 

 

  4) รันโปรแกรม จะได้ผลลพัธ์ตามภาพ 

 

  
ภาพท่ี 2.41 
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  2.3.5.8 คอมโพเนนต์ไทเมอร์ (Timer) 

    การใช้คอมโพเนนต์ไทเมอร์จะท าให้มีการท างานบางอย่างในทุกๆ ช่วงเวลาที่เรา

ก าหนด ซึ่งจะช่วยให้เราสามารถท าอย่างอื่น โดยทิ้งโปรแกรมนี้ให้ท างานตามเวลาที่ตั้งไว้ คอมโพเนนต์ไทเมอร์

จัดเป็นคอนโทรลประเภทที่เรียกว่า Non Visual interface หมายถึง จะไม่เห็นตัวคอนโทรลในขณะที่ รัน

โปรแกรมขึ้นมา ซึ่งจะพบได้บ่อยในการประยุกต์สร้างเกม แบบทดสอบ หรือการจ ากัดเวลาในการแสดงหน้าจอ

การท างานบางอย่าง 

- อีเวนต์ที่ส าคัญของ Timer คือ Tick เป็นอีเวนต์ที่เกิดข้ึนในทุกช่วงเวลาที่เราได้ก าหนด

ไว้ในคุณสมบัติ Interval 

- เมธอดของไทเมอร์ Start() คือเริ่มจับเวลา และ Stop() คือหยุดจับเวลา 

ตัวอย่างโปรแกรมการแสดงเวลาโดยใช้ไทเมอร์ 

  1) สร้างโปรเจ็กต์ใหม่ข้ึนมา จากนั้นวางคอนโทรลและคอมโพเนนต์บนฟอร์ม และก าหนดคุณสบัติ

ของไทเมอร์ ดังภาพ 

 
ภาพท่ี 2.42 
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ภาพท่ี 2.43 

   2) ดับเบิล้คลิกที่คอมโพเนนต์ Timer เข้าสู่หน้าต่าง Code Editor ใส่ค าสั่งดงันี ้

 
ภาพท่ี 2.44 

   My.Computer.Clock.LocalTime.ToLongTimeString คือ การดึงเวลาปจัจบุันบน

คอมพิวเตอรเ์ครื่องนั้นออกมาอยู่ในรปูของข้อความ 

   3) คลิกรันโปรแกรมจะได้ผลลพัธ์ตามภาพ 

 
ภาพท่ี 2.45 
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ตัวอย่างการท าแบบทดสอบแบบจับเวลา 

  โปรแกรมต่อไปนี้จะแสดงการใช้งานคอมโพเนนต์ไทเมอร์ โดยจะใช้เมธอด Start() เริม่จบัเวลา เมื่อ

มีการตอบค าถาม และเมธอด Stop() จะหยุดการจบัเวลา และหากไม่สามารถตอบในเวลาทีก่ าหนด จะเรียกใช้

เมธอด Stop() เพื่อหยุดการจับเวลา 

  1) สร้างโปรเจ็กต์ใหม่ขึ้นมา จากนั้นวางคอนโทรลและคอมโพเนนต์ต่างๆ ดังภาพ 

 
ภาพท่ี 2.46 

  2) ไปที่หน้าต่าง Code Editor ก าหนดตัวแปร count = 60 เป็นเวลาในการท าแบบทดสอบหนึ่ง

ข้อ และตัวแปล time เก็บจ านวนเวลาที่ใช้ในการท าแบบทดสอบ 

  3) คลิกพื้นที่ว่างบนฟอรม์ จากนั้นไปที่หน้าต่างคุณสมบัติและแท็บ Events ให้ดับเบลิคลิกีอ่ีเวนต์ 

Load จะเข้าสูห่น้าต่าง Code Editor ส าหรับเขียนโค้ดการท างานในหน้า Load ของ Form1 โดยให้ก าหนด 

Interval ค่าการจับเวลาและเรียกใช้เมธอด Start() ให้ไทเมอร์เริ่มจับเวลา 
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ภาพท่ี 2.47 

 

  4) ดับเบลิคลิกที่ปุม่กด จะแสดงหน้าต่าง Code Editor จากนั้นแทรกโค้ดหยุดนับเวลา ตรวจ

ค าตอบ แสดงผลค าตอบและเวลาที่ใช้ไป 

  5) ดับเบิลคลิกที่คอมโพเนนต์ไทเมอร์ในกรอบด้านล่าง จะแสดงหน้าต่าง Code Editor และเกิดอี

เวนต์ Timer1_Tick จากนั้นให้แทรกโค้ดส าหรับแสดงการนับเวลาถอยหลัง หยุดจับเวลาเมื่อหมดเวลา และ

แสดงกล่องข้อความแจ้ว่าผู้ใช้ไม่สามารถตอบค าถามในเวลาที่ก าหนด 

 
ภาพท่ี 2.48 

   

  6) รันเพื่อทดสอบโปรแกรม 



32 
 

  2.3.5.9 คอนโทรลสกรอลบาร์ (ScrollBar) 

   สกรอลบาร์จะใช้ในโอกาสที่ไม่สามารถแสดงผลข้อมูลทั้งหมดได้ในคราวเดียว เนื่องจากมี

พื้นที่จ ากัด หรืออาจจะใช้เป็นอินพุตในการปรับค่าข้อมูลก็ได้ ซึ่งคอนโทรลสกรอลบาร์จะมีทั้งในแนวนอนและ

แนวตั้ง ดังนี้ 

ตัวอย่างโปรแกรมแสดงการใช้งานสกรอลบาร์ 

  ตัวอย่างโปรแกรมนี้จะแสดงการใช้งานคอนโทรลสกรอลบาร์ โดยจะรับค่ารัศมีวงกลมผ่านทางสก

รอลบาร์แล้วแสดงค่ารัศมี และค านวณพื้นที่วงกลมมาทางเท็กซ์บ็อกซ์ 

  1) สร้างโปรเจ็กต์ใหม่ขึ้นมา จากนั้นวางคอนโทรลต่างๆ ดังต่อไปนี้ 

 
ภาพท่ี 2.49 

  2) ดับเบิล้คลิกที่สกรอลบาร์ จะเข้าสูห่น้าต่าง Code Editor ส าหรบัเขียนโปรแกรม และแทรกโค้ด 

ดังต่อไปนี ้

 
ภาพท่ี 2.50 



33 
 

  3) คลิกที่คอนโทรล HScrollBar1 จากนั้นไปที่ Properties และดูที่แทบ็ Events ให้ดับเบิ้ลคลิกที่อี

เวนต์ ValueChanged จะเข้าสูห่น้าต่าง Code Editor ส าหรบัเขียนโปรแกรม โดยให้แทรกโค้ดน าค่ารัศมีจาก

การปรับสกอรลบารม์าค านวณหาพื้นที่ของวงกลมและแสดงผลใน TextBox2 

 
ภาพท่ี 2.51 

  4) รันโปรแกรมจะไดผ้ลลัพธ์ดังภาพ 

 
ภาพท่ี 2.52 

 



 
 

Chapter 3  
พื้นฐานการเขียนโปรแกรม 

 
3.1 การเขียนโปรแกรมแบบ Console App 
 การเริ่มต้นเขียนโปรแกรมอาจจะมีโค้ด 4-5 บรรทัดเท่านั้น ดังนั้นเราอาจเขียนโปรแกรมขนาดเล็กแบบ
เท็กซ์โหมด หรือ DOS Command line จะท างานโดยการพิมพ์ค าสั่งทีละบรรทัด เพื่อให้ง่ายต่อการศึกษาค าสั่ง
พ้ืนฐาน หรือเรียกโปรแกรมชนิดนี้ว่า Console App โดยทดลองเขียนโปรแกรมเบื้องต้นดังนี้ 

 
ภาพที่ 3.1 
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ภาพที่ 3.2 

 
 เมื่อทดลองเขียนโปรแกรมแล้วสั่งรัน จะได้ผลลัพธ์ดังภาพที่ 3.3 

 
ภาพที่ 3.3 

 
- เมธอด Write จะแสดงข้อความภายในเครื่องหมาย “ ” และแสดงเคอร์เซอร์อยู่ในบรรทัดเดิม 
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- เมธอด Writeline จะแสดงข้อความภายในเครื่องหมาย “ ” ตรงต าแหน่งที่เคอร์เซอร์กะพริบอยู่ 
จากนั้นจะเลื่อนเคอร์เซอร์ขึ้นบรรทัดใหม่ 

- เมธอด Readline สั่งให้โปรแกรมหยุดรอผู้ใช้กดปุ่ม <Enter> ซึ่งเราจะใส่เมธอดนี้ไว้เพื่อเปิดหน้าจอ 
Console แสดงผลลัพธ์ค้างไว้ หากไม่ใส่ Readline เมื่อรันโปรแกรมเสร็จหน้าจอ Console จะปิด
ทันที ท าให้ไม่สามารถดูผลลัพธ์ของโปรแกรมได้ 

 
3.2 การเขียนค าสั่งในรูปแบบต่างๆ 
 3.2.1 การแบ่งค าสั่งบรรทัดหนึ่งออกเป็นหลายบรรทัด 
  เราสามารถแยกบรรทัด ด้วยอักขระช่องว่างแล้วตามด้วยอักขระ _  

 

 
ภาพที่ 3.4 

 3.2.2 การรวมค าสั่งหลายบรรทัดในบรรทัดเดียว 
  เราสามารถรวมหลายค าสั่งให้อยู่ในบรรทัดเดียวกัน โดยใช้เครื่องหมาย : เพ่ือแยกแต่ละค าสั่งออก
จากกัน ตัวอย่างเช่น 
 
 

 

 
ภาพที่ 3.5 

 
3.3 ตัวแปร ค่าคงท่ี และชนิดของข้อมูล 
 3.3.1 ตัวแปร (Variable) 
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  ตัวแปรใน VB มีหน้าที่เก็บข้อมูลในการท างานของโปรแกรมไว้เป็นการชั่วคราว ตัวแปรที่เราก าหนด
ขึ้นมาจะต้องประกอบด้วยชื่อตัวแปรและชนิดของข้อมูล (Data Type) ที่ตัวแปรเก็บได้ เราสามารถประกาศตัว
แปรได้โดยมีรูปแบบดังนี้ 

 

 
ภาพที่ 3.6 

 การตั้งชื่อตัวแปร มีกฎดังนี้ 
- จะต้องเริ่มต้นด้วยตัวอักขระ A-Z, a-z หรือ _ 
- จะต้องประกอบด้วยเฉพาะตัวอักขระ A-Z, a-z, 0-9 หรือ _ 
- ถ้าเริ่มต้นตัวแรกด้วย _ จะต้องตามด้วยตัวอักขระหรือตัวเลขอย่างน้อยหนึ่งตัว 
- มีความยาวไม่เกิน 1023 ตัวอักษร 
- ชื่อตัวแปรต้องไม่ซ้ ากันในขอบเขตเดียวกัน  
- ชื่อต้องไม่ซ้ ากับค าสงวน (Reserved Word) ของ VB เช่น ค าว่า Dim, If, Set ไม่ได้ 
- ไม่ว่าใช้ตัวอักษรพิมพ์เล็กหรือพิมพ์ใหญ่ให้ความหายเหมือนกัน 

  
ตัวอย่างชื่อตัวแปรที่ถูกต้อง ตัวอย่างชื่อตัวแปรที่ผิด 

Salary_12m Salary$12 
_30 12Salary 
_wks _ 

Event 
 

 
 
 3.3.2 ขอบเขตการประกาศตัวแปร (Scope of variable) 
  ในการประกาศตัวแปร เราสามารถก าหนดว่าจะให้ตัวแปรนั้นมองเห็นในส่วนใดของโปรแกรมได้
บ้าง เช่น ต้องการให้เข้าถึงตัวแปรได้เฉพาะในโปรแกรมย่อยเท่านั้น หรือให้ทุกโปรแกรมย่อยให้คลาสนั้นเห็น
ทั้งหมด เป็นต้น 
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  เมื่อประกาศตัวแปรโดยใช้คีย์เวิร์ด Public น าหน้าชื่อตัวแปร ความหมายคือ ทุกส่วนของโปรแกรม
สามารถมองเห็นและเข้าถึงใช้งานตัวแปรนี้ได้ ส่วนการใช้คีย์เวิร์ด Private น าหน้าชื่อตัวแปร ความหมาย คือ 
มองเห็นและเข้าถึงตัวแปรได้เฉพาะในโปรแกรมย่อยส่วนนั้น ดังภาพที่ 3.7 

 

 
 

ภาพที่ 3.7 
 

 3.3.3 ตัวแปรแบบสเตติก (Static Variables) 
  ตัวแปรระดับโปรแกรมย่อย (ตัวแปรที่ถูกประกาศในโปรแกรมย่อย) จะใช้ได้เฉพาะในขณะที่การ
ท างานอยู่ในโปรแกรมย่อยเท่านั้น ซึ่งหลังจากโปรแกรมย่อยท างานเสร็จแล้ว ตัวแปรนั้นก็จะถูกท าลาย และเมื่อ
มีการเรียกใช้งานโปรแกรมย่อยนั้นอีกครั้ง ตัวแปรระดับโปรแกรมย่อยก็จะถูกสร้างขึ้นมาใหม่ ซึ่งอาจท าให้ค่า
ของตัวแปรไม่ใช่ค่าเก่าอีกต่อไป แต่เราสามารถใช้ค าสั่ง Static แทน Dim ในการประกาศตัวแปรเพ่ือรักษาค่า
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ล่าสุดของตัวแปร หลังจากเราออกจากโปรแกรมย่อยไว้ได้ โดยเมื่อเราเรียกใช้โปรแกรมย่อยอีกครั้ง ตัวแปรนี้ก็
ยังคงเก็บค่าล่าสุดที่ก าหนดไว้ 
ตัวอย่างโปรแกรม การนับจ านวนครั้งของการคลิกเมาส์ว่าปุ่มค าสั่ง จะแสดงกล่องข้อความว่าคลิกไปแล้วกี่ครั้ง 
 

 

 
ภาพที่ 3.8 

  
 
 
 
 
 
 
 3.3.4 ค่าคงที่ (Constants) 
  ค่าคงที่มีไว้ส าหรับเก็บค่าที่ไม่เปลี่ยนแปลงตลอดช่วงเวลาที่โปรแกรมรันอยู่ ซึ่งถ้าในโปรแกรมมีการ
ใช้ค าสั่งทีเ่ปลี่ยนค่าคงที่ VB ก็จะแสดงข้อผิดพลาดขึ้นมา เพราะเราเปลี่ยนค่าท่ีประกาศเป็นค่าคงที่ไม่ได้ 
  การประกาศค่าคงที่มีลักษณะเดียวกับการประกาศตัวแปร โดยใช้ค าสั่งที่มีรูปแบบดังนี้ 
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  ในการประกาศค่าคงที่ เราสามารถก าหนดชนิดข้อมูลของค่าคงที่และก าหนดค่าเป็นตัวเลข 
ข้อความ ค่าในตัวแปร หรือใช้ตัวด าเนินการร่วมในการก าหนดค่าได้  
ตัวอย่างการประกาศค่าคงที่ 

 
และเราสามารถน าค่าท่ีประกาศมาใช้ในโปรแกรมได้ดังนี้ 

จากค าสั่งข้างต้น จะเป็นการหาพื้นที่วงกลมจากสูตร PI* 
(ความยาวรัศมียกก าลังสอง) ส าหรับของเขตการประกาศ
ค่าคงที่ จะเหมือนกับของเขตการประกาศตัวแปรดังที่ได้

อธิบายไว้แล้ว 
 3.3.5 ชนิดของข้อมูล (Data Types) 
  ชนิดของข้อมูลที่เราก าหนดให้กับตัวแปรจะท าให้การเก็บข้อมูลของเรามีประสิทธิภาพ เพราะใช้
พ้ืนที่ขนาดเหมาะสมในการเก็บข้อมูล โดยใน VB จะมีชนิดข้อมูลต่างๆ ดังนี้ 

ชนิด ขนาด (ไบต์) ค าอธิบาย 
ชนิดข้อมูลแบบตัวเลขจ านวนเต็ม  
จะใช้เก็บเฉพาะเลขจ านวนเต็มที่ใช้บ่อยในการเขียนโปรแกรม เช่น 101, 0, -30 เป็นต้น 
Byte 1 มีค่าตั้งแต่ 0-255 แต่ละบิตใช้แทนเลข 0 และ 1 ซึ่งเป็นเลขฐานสอง 
Char 2 มีค่าตั้งแต่ 0-65535 
Short 2 มีค่าตั้งแต่ –32,768 ถึง 36,768 
Integer 4 มีค่าตั้งแต่ -2,147,483,648 ถึง 2,147,483,648 
Long 8 มีค่าตั้งแต่ –9,223,372,036,854,775,808 ถึง  

9,223,372,036,854,775,808 
ชนิดข้อมูลแบบเลขทศนิยม จะใช้เก็บเฉพาะเลขจ านวนทศนิยมส าหรับใช้ในการค านวณทางคณิตศาสตร์และ
วิทยาศาสตร์ เช่น 101.34, 0.22, -55.36 เป็นต้น (ตัวอักษร E จะหมายถึงยกก าลังเช่น 1.7E35 เท่ากับ       
1.7 x 1035 เป็นต้น 
Single 4 เก็บเลขทศนิยมที่มีความละเอียดต่ า มีค่าตั้งแต่ 

ค่าลบ   -3.4028235E+38 ถึง -1.401298E-45 
ค่าบวก  1.401298E-45  ถึง 3.4028235E+38 

Double 8 เก็บเลขทศนิยมความละเอียดสูง มีค่าตั้งแต่ 
ค่าบวก 4.94065645841246544E-324 ถึง 
1.79769313486231570E+308 
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ชนิด ขนาด (ไบต์) ค าอธิบาย 
ค่าลบ -1.79769313486231570E+308 ถึง 
-4.94065645841246544E-324 และ 0 

Decimal 16 เก็บตัวเลขขนาดใหญ่มาก 
ชนิดข้อมูลทั่วไป ชนิดข้อมูลทั่วไปนี้จะใช้เก็บข้อความ เก็บค่า True (จริง) หรือ False (เท็จ) อย่างในอย่างหนึ่ง 
และเก็บค่าวันที่ 
Boolean - มีค่า True กับ False (ใช้ขนาดพ้ืนที่หน่วยความจ าต่างกันขึ้นกับ

แพลตฟอร์ม) 
String - เก็บตัวอักษรได้ 0 ถึง สองพันล้านอักขระ (2^31 และขนาดขึ้นอยู่กับ

แพลตฟอร์ม) 
Date 8 เก็บข้อมูลที่ใช้แทนวันที่และเวลา ตัวอย่างการใช้งาน เช่น 

 
Object 4/8 4 ไบต์บนแพลตฟอร์ม 32 บิตหรือ 8 ไบต์บนแพลตฟอร์ม 64 บิต เก็บ

ข้อมูลที่ใช้ในการอ้างอิงถึงออบเจ็กต์ต่างๆ ถ้าเราประกาศตัวแปรโดยที่
ไม่ได้ระบุชนิดข้อมูล ชนิดข้อมูลของตัวแปรตังนั้นก็จะถูกก าหนดเป็น 
Object ทันที เช่น Dim Test 
ตัวแปร Test จะเป็นชนิด Object ทันที่ 

 3.3.6 ตัวด าเนินการในการค านวณทางคณิตศาสตร์ 
การกระท า สัญลักษณ์ 

การบวก + 
การลบ - 
การคูณ * 
การหาร / 
การหารแบบจ านวนเต็ม \ 
การหารเอาเศษ Mod 
การยกก าลัง ^ 

 
 3.3.7 ตัวด าเนินการในทางตรรกะ จะให้ผลลัพธ์เป็นค่า True และ False 

A B A And B 
True True True 
True False False 
False True False 
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False False False 
 

A B A OR B 
True True True 
True False True 
False True True 
False False False 

 
A B A XOR B 

True True False 
True False True 
False True True 
False False False 

 
A B A AndAlso B 

True True True 
True False False 
False ไม่มีการหาค่า False 

   
  ตัวด าเนินการ AndAlso  จะคล้ายกับตัวด าเนินการ And ยกเว้นแต่ว่าถ้านิพจน์แรกมีค่าเป็น 
False ก็จะไม่หาค่านิพจน์ที่สองเลย และจะให้ผลลัพธ์กับมาเป็น False 
 

A B A ORElse B 
True ไม่มีการหาค่า True 
True False True 
False False False 

   
  ตัวด าเนินการ ORElse จะคล้ายกับตัวด าเนินการ Or ยกเว้นแต่ว่านิพจน์แรกมีค่าเป็น True ก็จะไม่
หาค่านิพจน์ที่สองเลย และจะให้ผลลัพธ์กลับมาเป็น True 
 

A Not A 
True False 
False True 
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 3.3.8 ตัวด าเนินการในการท างานเกี่ยวกับข้อมูลชนิด String  
  ตัวด าเนินการกลุ่มนี้จะใช้เชื่อม String กับ String เข้าด้วยกัน หรือ String กับข้อมูลตัวเลขก็ได้ 

 ใช้ + เชื่อม String กับ String เช่น 

 
 ใช้ & เชื่อม String กับข้อมูลแบบ Numeric หรือ String ก็ได้ เช่น 

 
 
 
 3.3.9 ตัวด าเนินการเปรียบเทียบ 
  ตัวด าเนินการประเภทนี้จะใช้เปรียบเทียบระหว่างค่า 2 ค่า โดยมีผลลัพธ์เป็น True หรือ False 
อย่างใดอย่างหนึ่งเท่านั้น ดังนี้ 

สัญลักษณ์ของตัวด าเนินการ ความหมาย 
= เท่ากับ 
<> ไม่เท่ากับ 
< น้อยกว่า 
> มากกว่า 
<= น้อยกว่าหรือเท่ากับ 
>= มากกว่าหรือเท่ากับ 

 
 3.3.10 ล าดับในการท างานของตัวด าเนินการ 
 
3.4 รับข้อมูลจากผู้ใช้ด้วยเมธอด InputBox 
 เป็นช่องรับข้อมูลบนไดอะล็อกบ็อกซ์ เหมาะส าหรับการรับข้อมูลจากผู้ใช้เพียงค่าเดียว โดยกรอกข้อความ
หรือตัวเลขลงในช่องรับข้อมูล จากนั้นให้คลิกปุ่ม OK ข้อมูลก็จะถูกรับเข้ามาด าเนินการในโปรแกรม InputBox 
เป็นเมธอดของคลาส Interaction ที่สามารถอ้างอิงเรียกใช้งานได้ทั้งในโปรเจ็กต์ชนิด Windows Forms App 
และ Console App แต่ไม่สามารถน าไปใช้กับภาษาอ่ืนใน .NET ได้ เพราะเป็นเมธอดสมาชิกของเนมสเปซ 
Microsoft.VisualBasic ที่ไม่ใช่ .NET 
 รูปแบบ 
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 Message สตริงที่ต้องการให้แสดงเป็นข้อความในไดอะล็อกบ็อกซ์ เพื่อแจ้งให้ผู้ใช้ทราบว่าต้องการให้ป้อน
ข้อมูลอะไร มีความยาวได้ 1,024 ตัวอักษร 
 Title  สตริงที่ต้องการให้แสดงเป็นข้อความในไตเติลบาร์ของไดอะล็อกซ์บ็อกซ์ 
 defaultValue สตริงที่ต้องการให้แสดงเป็นข้อความในช่องรับข้อมูล หากผู้ใช้ไม่ป้อนข้อมูลใดๆ ลงไป 
ข้อความที่เป็นค่าเริ่มต้นนี้จะถูกรับเข้ามาในโปรแกรม เพ่ือป้องกันไม่ให้โปรแกรมท างานผิดพลาด 
 Xpos ตัวเลขระยะห่างระหว่างขอบด้านซ้ายของไดอะล็อกบ็อกซ์จากขอบด้านซ้ายของจอภาพ 
 Ypos ตัวเลขระยะห่างระหว่างขอบด้านบนของไดอะล็อกบ็อกซ์จากขอบด้านบนของจอภาพ 
จากตัวอย่างเมื่อรันโค้ดจะได้ผลลัพธ์ดังภาพ 

 
ภาพที่ 3.9 

3.5 แสดงกล่องข้อความ MsgBox 
 เป็นกล่องแสดงข้อความเพ่ือแจ้งผลลัพธ์จากการค านวณ วิเคราะห์ข้อมูล แสดงสถานะการท างาน หรือการ
แจ้งเตือนต่างๆ แก่ผู้ใช้ ซึ่งจะรอจนผู้ใช้รับทราบข้อมูลแล้วคลิกปุ่ม OK เพ่ือยืนยันและปิด MsgBox เป็นเมธอด
ของคลาส Interaction ที่สามารถอ้างอิงเรียกใช้งานได้ทั้งในโปรเจ็กต์ชนิด Windows Forms App และ 
Console App รวมทั้งอยู่ในเนมสเปซ Microsoft.VisualBasic ที่ไม่ใช่ .NET จึงไม่สามารถรองรับการใช้งานกับ
ภาษาอ่ืนใน .NET ได ้
รูปแบบ 

 
ผลลัพธ์ 
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 Message สตริงที่ต้องการให้แสดงเป็นข้อความในไดอะล็อกบ็อกซ์ยาวไม่เกิน 1,024 
ตัวอักษร 

 Style รูปแบบของปุ่มและไอคอนที่ต้องการให้แสดงในไดอะล็อกบ็อกซ์ 

 Title สตริงที่ต้องการให้แสดงเป็นข้อความในไตเติลบาร์ของไดอะล็อกบ็อกซ์ 
รูปแบบของ Style 

รูปแบบสไตล์ ค าอธิบาย 
Okonly แสดงเฉพาะปุ่ม OK 
OKCancel แสดงปุ่ม OK และ Cancel 
AbortRetryIgnore แสดงปุ่ม Abort, Retry และ Ignore 
YesNoCancel แสดงปุ่ม Yes, No และ Cancel 
YesNo แสดงปุ่ม Yes และ No 
RetryCancel แสดงปุ่ม Retry และ Cancel 
Critical แสดงไอคอนข้อความส าคัญ 
Question แสดงไอคอนค าถาม 
Exclamation แสดงไอคอนข้อความแจ้งเตือน 
Information แสดงไอคอนข้อความแจ้งข่าวหรือประชาสัมพันธ์ 
DefaultButton1 ก าหนดปุ่มแรกเป็นดีฟอลต์ 
DefaultButton2 ก าหนดปุ่มที่สองเป็นดีฟอลต์ 
DefaultButton3 ก าหนดปุ่มที่สามเป็นดีฟอลต์ 
ApplicationModal ก าหนดให้ผู้ใช้ตอบสนองก่อนจะกลับไปท างานในแอพพลิเคชันต่อไป 
SystemModal หยุดการท างานของแอพพลิเคชันทั้งหมดจนกว่าผู้ใช้จะตอบสนองต่อ

กล่องข้อความ 
MsgBoxSetForeground ก าหนดให้กล่องข้อความปรากฏขึ้นมาซ้อนอยู่บนหน้าต่างการท างาน

อ่ืนๆ 
MsgBoxRight ก าหนดให้ข้อความชิดขวา 
MsgBoxRtlReading แสดงข้อความส าหรับการอ่านจากขวาไปซ้าย เช่น ภาษาฮิบรู และอา

รบิก 
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ตัวอย่างการใช้เมธอด InputBox และ MsgBox 
 เป็นโปรแกรมค านวณค่าแรงนอกเวลาของคนงาน โดยจะแสดงกล่องรับข้อมูลให้ผู้ใช้กรอกจ านวนชั่วโมง
การท างานนอกเวลา จากนั้นโปรแกรมจะท าการค านวณค่าแรงด้วยชั่วโมงละ 70 บาท และแสดงค่าบนกล่อง
ข้อความ 
 1) สร้างโปรเจ็กต์ใหม่ข้ึนมาชนิด Console App  
 2) ปรากฏหน้าต่างส าหรับเขียนโค้ด ให้เขียนดังนี้ 

 
ภาพที่ 3.10 

 
3.6 แสดงกล่องข้อความ MessageBox 
 เป็นกล่องข้อความในลักษณะเดียวกันกับ MsgBox ต่างกันที่ MessageBox เป็นคลาสใน .NET ซึ่งสามารถ
รองรับการใช้งานกับภาษาอ่ืนๆใน .NET ได้ มีเมธอดที่นิยมใช้งานได้แก่ 

เมธอด ค าอธิบาย 
Show(message) แสดงเฉพาะข้อความ 
Show(message, title) แสดงข้อความและชื่อไตเติล 
Show(message, title, button) แสดงข้อความ ชื่อไตเติล และปุ่มแบบต่างๆ 
Show(message, title, button, icon) แสดงข้อความ ชื่อไตเติล ปุ่มแบบต่างๆ และ ไอคอนต่างๆ 

 

 message สตริงที่ต้องการให้แสดงเป็นข้อความในไดอะล็อกบ็อกซ์ 

 title สตริงที่ต้องการให้แสดงเป็นข้อความในไตเติลบาร์ของไดอะล็อกบ็อกซ์ 

 button ก าหนดค่าแสดงปุ่มในรูปแบบต่างๆ ในไดอะล็อกบ็อกซ์ 
รูปแบบปุ่ม ค าอธิบาย 

AbortRetryIgnore แสดงปุ่ม Abort, Retry และ Ignore 
OK แสดงปุ่ม OK 
OKCancel แสดงปุ่ม OK และ Cancel 
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RetryCancel แสดงปุ่ม Retry แล Cancel 
YesNo แสดงปุ่ม Yes และ No 
YesNoCancel แสดงปุ่ม Yes, No และ Cancel 

 

 icon ก าหนดค่าแสดงไอคอนในรูปแบบต่างๆ ให้กับไดอะล็อกบ็อกซ์ 
รูปแบบไอคอน ค าอธิบาย 

Asterisk แสดงไอคอนค าอธิบายประกอบ 
Error แสดงไอคอนแจ้งความผิดพลาด 
Exclamation แสดงไอคอนเครื่องหมายอัศเจรีย์ 
Hand แสดงไอคอนการดูแล 
Information แสดงไอคอนแจ้งข้อมูล 
None ไม่มีไอคอนสัญลักษณ์ 
Question แสดงไอคอนเครื่องหมายค าถาม 
Stop แสดงไอคอนเครื่องหมายหยุด 
Warning แสดงไอคอนแจ้งเตือนข้อควรระวัง 

 
รูปแบบ 

 
ผลลัพธ์ 

 
 

ตัวอย่าง การใช้กล่องข้อความแสดงผลลัพธ์การค านวณราคาหนังสือทั้งหมด  
 1) สร้างโปรเจคชนิด Windows Forms App ขึน้มาใหม่ แล้วจัดวางคอนโทรลดังภาพ 
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ภาพที่ 3.11 

 
 2) ดับเบิลคลิกปุ่มเพ่ือเข้าสู่หน้าต่าง Code Editor เขียนโค้ดดังนี้ 

 
ภาพที่ 3.12 

  
 3) ผลลัพธ์ที่ได้จากการรันโปรแกรม 

 
ภาพที่ 3.13 

3.7 การแปลงข้อมูลขั้นพื้นฐาน 
 3.7.1 ฟังก์ชั่นการแปลงข้อมูลแบบ In Line เป็นการแปลงข้อมูลโดยคอมไพล์แบบอินไลน์ที่ท างานอย่าง
รวดเร็ว มีฟังก์ชันที่นิยมใช้งาน ดังนี้ 

ฟังก์ชัน ไปเป็นข้อมูลชนิด ตัวอย่างการใช้งาน ผลลัพธ์ 
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CByte Byte CByte("234.123") 234 

CInt Integer CInt("3000.457") 3000 

CLng Long CLng("10000000") 10000000 

CCur Currency CCur("4598.8976") 4598.8976 

Csng Single CSng("10000.7117") 10000.71 

CDbl Double CDbl("10000.7117") 10000.7117 

CDate Date CDate("7 Jan 2561") 1/7/2561 

CStr String CStr(975.7773) "975.7773" 
 
 3.7.2 เมธอดในคลาส Convert เป็นกลุ่มของเมธอดส าหรับแปลงข้อมูลจากชนิดหนึ่งไปเป็นชนิดอื่น ซึ่งมี
เมธอดท่ีนิยมใช้งานดังนี้ 

ชื่อ รายละเอียด 

ToBoolean เปลี่ยนจากค่าที่ก าหนดไปเป็นข้อมูลชนิด Boolean ที่สอดคล้องกัน 

ToByte เปลี่ยนจากค่าที่ก าหนดไปเป็นข้อมูลชนิด Byte (8-bit unsigned integer) 

ToChar เปลี่ยนจากค่าที่ก าหนดไปเป็นข้อมูลชนิด Char 

ToDateTime เปลี่ยนจากค่าที่ก าหนดไปเป็นข้อมูลชนิด DateTime 

ToDecimal เปลี่ยนจากค่าที่ก าหนดไปเป็นข้อมูลชนิด Decimal 

ToDouble เปลี่ยนจากค่าที่ก าหนดไปเป็นข้อมูลชนิด Double 

ToInt16 เปลี่ยนจากค่าที่ก าหนดไปเป็นข้อมูลชนิด Short (16-bit signed integer) 

ToInt32 เปลี่ยนจากค่าที่ก าหนดไปเป็นข้อมูลชนิด Integer (32-bit signed integer) 

ToInt64 เปลี่ยนจากค่าที่ก าหนดไปเป็นข้อมูลชนิด Long (64-bit signed integer) 

ToSingle เปลี่ยนจากค่าที่ก าหนดไปเป็นข้อมูลชนิด Single 

ToString เปลี่ยนจากค่าที่ก าหนดให้อยู่ในรูปแบบสตริง 
 

 3.7.3 เมธอด TryParse เป็นการแปลงข้อมูลชนิดข้อความให้เป็นชนิดตัวเลข โดยเมื่อแปลงข้อมูลส าเร็จจะ
ได้ค่าตามตัวเลขที่รับข้อมูลมา แต่หากไม่ส าเร็จ ผลลัพธ์ที่ได้จะเป็นค่า 0 ซึ่งโปรแกรมยังคงท างานต่อได้ มี
รูปแบบดังนี้ 
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 3.7.4 เมธอด Val แปลงตัวเลขที่ถูกรวมอยู่ในข้อความให้ออกมาเฉพาะค่าตัวเลข โดยต้องขึ้นต้นด้วย
ตัวเลข มีรูปแบบดังนี้ 

 




